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@ ECHOMASTER

EchoMaster is a global leader of vehicle
safety products and video telematics
solutions and a brand of AAMP Global.

AAMP Global is a worldwide supplier
of vehicle aftermarket and OEM
technology committed to providing
end-to-end solutions for their
commercial partners.
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SAFETY TECHNOLOGY
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PROVIDER.
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In a world where road accidents are commonplace, fleet operators
are always looking at ways to reduce risk, increase safety, and
protect their vehicles and investments.

Our vision and expertise of the commercial automotive industry has enabled us to
develop cutting-edge products and technology with first class customer support and
project management, helping vehicle owners and their drivers to reduce risk, increase
safety, and protect vulnerable road users. We strive to add value and peace of mind to
your business while developing long term customer relationships.

Experts in

Automotive Technology Solutions

Hardware, Software & Mechanical Engineering
Harness Design & Development

CAN-Bus Integration

OVER 30 UK-BASED UK-BASED UK-BASED DEDICATED RIGOROUS
YEARS TECHNICAL PRODUCTION DEVELOPMENT PROJECT QUALITY
EXPERIENCE SUPPORT TEAM FACILITIES CENTRE MANAGEMENT MANAGEMENT

INNOVATION
THROUGH EXPERIENCE.

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com

INDUSTRIES
WE SUPPORT

EchoMaster provides a full range of safety products and
video telematics solutions to address the unique needs of
the industries we serve. Our team are ready to partner with
you to understand your specific business requirements and
listen to your ideas.

We are proud to design, engineer and manufacture products and
solutions tailored to your business. From conception to launch, quality
and durability are key pillars of our development and manufacturing

process.
AGRICULTURE BUS & COACH BLUE / YELLOW LIGHT

()

() ()

CONSTRUCTION FREIGHT & HAULAGE LEISURE

()

REFUSE & WASTE

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com
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ENGINEERING
CAPABILITIES

the globe.

CAN Bus Integration

Harness Design & Development
Part and Mold Design

3D CAD Design

QA Testing

OEM Integration

VVVVYVYY
VVVVYVYY

TO QUALITY

technology right across the globe.

6

With decades of experience, our global engineering team
includes mechanical, electrical, and software expertise to real-world testing in our on-site testing facilities and through
advance vehicles with proprietary technology right across additional third-party testing locations.

Specialising in premium, fully integrated products to deliver a factory-like are designed and tested to achieve the highest possible quality standards for fit,
experience in both commercial and passenger vehicles. finish and function.

©

MECHANICAL ELECTRICAL SOFTWARE

A COMMITMENT

Our global engineering team includes mechanical, electrical,
and software expertise and advances vehicles with proprietary

Specialising in premium, fully integrated products to deliver a factory-like
experience in both commercial and passenger vehicles.

TESTING
STANDARDS

Every product goes through rigorous element, functional and

From cameras, monitors, sensors and DVRs, all our commmercial-grade solutions

Vehicle Data Bus

PCB Development

Application Development

Radio Head Unit Interfaces (GUI)
Cloud Based Systems

Large Virtual Systems

00O

DURABILITY EMC ENVIRONMENTAL MECHANICAL
TESTING TESTING TESTING TESTING
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FEATURE-PACKED
Al-POWERED VEHICLE
SAFETY SOLUTIONS

In an era driven by technology, EchoMaster is pushing the
boundaries of automotive safety and efficiency with a range
of innovative Al-powered solutions.

By seamlessly integrating artificial intelligence into a host of cutting-edge systems,
EchoMaster are paving the way for a safer and more connected future on the roads.

By ultilising advanced algorithms, our Al-solutions instantly analyse vehicle
surroundings identify potential hazards and alert drivers to potential collisions or
dangerous situations. Improved object recognition also enabling systems to
accurately detect pedestrians, cyclists, and other vehicles, mean our solutions
provide excellent results in both challenging weather conditions or low-light
environments.

PEDESTRIAN
DETECTION
CAMERAS.

ADVANCED DRIVER
ASSISTANCE &
MONITORING.

MOBILE DVR
AlI-POWERED
ADD-ONS.

GOTO GOTO
PAGE 25 PAGE 45

+44(0)1420 487110 - sales@aampglobal.com

ALARMS
& WARNINGS
PROVIDED

Distance Detection
Forward Collision
Lane Departure
Pedestrian Detection
Phone Usage

No Smoking

Driver Distraction
Driver Fatigue

No Driver Warning

\ A AAAAAAAL
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ECHOMASTER

Helping to ensure the safety
& security of your vehicles with
our comprehensive cloud-based

Fleet Management Solution.

By combining extensive industry knowledge with exceptional levels of service, support,
and robust hardware we can provide your business with a bespoke solution designed
to deliver significant benefits and cost reductions across your fleet, improving both
safety and efficiency whilst also protecting your investment.

How our solution can benefit your business.

ENHANCED DUTY DRIVER TRAINING PROTECTS AGAINST LOWERS
OF CARE & REWARD FALSE CLAIMS

¥

INCREASED FLEET DETERS THEFT INCREASES PROTECTS

EFFICIENCY & VANDALISM

(((J)) ECHOMASTER

OPERATIONAL RISK

VEHICLE SAFETY YOUR INVESTMENT

How it works

Our intelligent Cloud-Based Fleet Management platform provides a complete
solution for video telematics, tailored to work with any vehicle and securely
connecting everything to the cloud as one system. Acting as your ‘video witness’
and accurately recording key video footage and analytics data for download for
use as evidence or to improve efficiency across your fleet, the combination of our
powerful platform and diverse product range makes EchoMaster Connected the
perfect solution for vehicles in any industry.

24[7 Access to your Fleet.

The Connected smart reporting suite allows you
to analyse the GPS and video data captured from
multiple cameras across your entire fleet. Instant
alerts to incidents mean that you can act quickly.
Triggers for harsh braking and dangerous driving
can be set and recorded to help identify and
train drivers saving expensive costs on vehicle
maintenance.

Analyse your Fleet in Real-Time

Gain a real-time insight into your fleet, live as it
happens and see your problem areas as they
occur. This allows you to act independently and
modify your strategy as you go to ensure your fleet
is working as quickly and efficiently as possible.

The system also allows you to develop accurate, to
the point reports to analyse and develop ongoing
strategies to improve the performance of your fleet.

Receive Instant Notifications

The combination of EchoMaster’s high-quality
hardware and Connected Smart Suite make sure

that in the event of an accident or custom set alarm
trigger you are notified as soon as possible. The system
will also notify you if drivers are putting vehicles at risk
through dangerous driving or driving whilst impaired.

Monitor your Fleet wherever
you are

Our Mobile App provides access to your entire fleet
on the go meaning you will never miss an update.
Providing an essential part of keeping you in touch
with your fleet it also allows you to view reports,
track individual drivers and even receive FNOL
notifications.
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COMPATIBLE
& COMPLIANT.

EchoMaster safety products provide a complete and comprehensive range of

innovative solutions to help achieve FORS accreditation and exceed exemplary Ac H I EVE Dvs
levels of best practice in safety, efficiency, and environmental protection.

Together with FORS compliance, fleet operators within the construction industry who achieve c o M P L I A N c E W I T H
FORS Silver accreditation also demonstrate full compliance with CLOCS: the Construction

Logistics and Community Safety scheme. As a benchmark for safety, CLOCS aims to help

operators become compliant across the entire supply chain which includes, but is not limited E c H o MAST E R
to, the implementation of safety solutions such as blind spot minimising, vehicle manoeuvring

warnings and warning signage on all road-going vehicles for the benefit of all road users.

DIRECT VISION STANDARD

Our range of comprehensive DVS compliant vehicle safety
solutions help your fleet achieve the Direct Vision Standard. Our range

FRONT-FACING MONITOR LEFT & RIGHT SIDE-FACING REAR-FACING includes better in-cab visibility with our multi-camera systems, blind-spot
CAMERAS SOLUTIONS TURN ALARMS CAMERAS CAMERAS detection sensors, warning alarms and digital video recorders.

©Lve

CONNECTED
SOLUTIONS

MONITOR
SOLUTIONS

DON'T FORGET...

From October 2024,
COMMERCIAL SIDE-ALERT all vehicles over 12
DVR SOLUTIONS SENSORS tonnes travelling into

Greater London will now be
required to achieve a
minimum 3 star rating, an
increase from the current O star
rating currently required.

L

BLIND SPOT MOVING-OFF FITTING
INFORMATION INFORMATION ACCESSORIES
FOR MORE INFORMATION ON BOTH SYSTEM (BSIS) SYSTEM (MOIS)

FORS & DVS COMPLIANCE
GO TO PAGES 55-57 .I 5



ECHOMASTER CLICK HERE TO OPEN
AN ACCOUNT >»»

BECOMING
AN ‘ECHOMASTER’ e -
with the EchoMaster Partner Program %

As an EchoMaster Partner you will get to provide your clients best-in-class vehicle

cameras, fleet risk management systems and driver safety solutions. EXCLUSIVE PRICING DEDICATED ACCOUNT

& DISCOUNTS MANAGER

But more importantly we have done all the heavy lifting to make the pre-sales and after-sales
process completely hassle-free, so you make more sales without the usual headaches of S
dealing with third-party aftermarket suppliers.

SALES SUPPORT TECHNICAL
MATERIAL SUPPORT

DESIGNED FOR WITH BENEFITS REQUIREMENTS.
YOUR BUSINESS To MATCH. The EchoMaster Partner Program is open to all

Designed for commercial vehicle dealers, body vehicle hire/leasing companies. The requirements

builders and vehicle hire/leasing companies. Access to market-leading vehicle are not extensive or overly complicated because
safety products and Fleet the program is simple and flexible.

Capitalise on the benefits that EchoMaster Management solutions

delivers to your customers. Exclusive pricing & discounts » Be a commercial vehicle dealer, body
On-site product & install training builder or leasing company.

Not only do you make margin from the sale, Complete technical support » Have a team of vehicle install technicians

but thanks to the onsite training provided to throughout the sales lifecycle available to be trained by us

your team, you also make revenue from the Direct access to our UK support team » Achieve reasonable minimum sales

installation of our hardware. by phone, email and real-time chat » Promote EchoMaster products within
Sales and product documentation, your showroom, vehicles, tradeshows

All this leads to improved customer guides and online videos and/or other relevant placements.

satisfaction and loyalty, opening up Sales Support materials, brochures, The specifics of which will be agreed as

opportunities for a broader relationship leaflets, special promotions part of the on boarding process.

with your customers and extending the Access to new products before Agree to install the EchoMaster products

relationship beyond the point of sale. general release. and solution in a demonstrator vehicle.

+44(0)1420 487110 - sales@aampglobal.com +44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com EchoMaster-eu.com '|7
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CAN-BUS

INTEGRATION
SPECIALISTS.

CANPRO is a powerhouse multi-output CAN Bus interface.

Our CANPRO CAN Bus interfaces are used in everything from cars, and commercial vehicles
to boats, Powersports, ATV's and mobile machinery. Offering customers bespoke solutions
to cover a variety of needs.

Our CANPRO interfaces have been developed by a team with over 25 years of experience
designing and implementing CAN Bus applications.

We understand and have the experience to know what works and what doesn’t, and we
work closely with our global customer base to ensure that our CAN-based products are
the best on the market.

Plug & Play Vehicle Interface with Vehicle Core OUtPUt Sig na I S

Specific Harness Specific Software

Accessory Power Status
Ignition Power Status
Dash lllumination Status
Reverse

Left Turn Signal

Right Turn Signal

Park Brake Status
Vehicle Speed (VSS)
High Beam Status

VVVVVVYYVYYVYY

Interface Connector 9 CAN-Outputs

9 SWITCHABLE ADD ACCESSORIES 8 HIGH [ 1LOW
OUTPUTS TO CAN SYSTEM LEVEL OUTPUT

18

Why use a CANPRO

CAN Bus interface?

P Our CANPRO Interfaces connect to the vehicle’s CANBUS
communications network and provide analogue signal outputs!

P CANPRO allows access vehicle information, status and triggers
from the vehicle CANBUS for a wide range of aftermarket uses.

P Our CANPRO interfaces are designed to be configured to the
customer’s requirements. Software can be programmed and the
interface pre-configured with a bespoke plug-and-play harness
for simple installation.

19



FORWARD & REAR-FACING CAMERAS

CAM-FFO1-FHD-P

Forward & Rear-Facing Cameras

CAM-FFO1-P-AHD CAM-IPC-FFO1

Side-Facing Cameras

Driver-Facing Cameras

Internal Forward-Facing

External Forward-Facing
FullHD 1080P Camera

Full HD 1080P Camera

Internal Forward-Facing
IPC Camera

» 1/2.8" CMOS Sensor »  720P AHD Image Sensor > 1/2.8" 2M Pixel CMOS Sensor
. »  Full 1080P Resolution »  Full HD 1920 x 960 Resolution »  Full HD 1920 x 1080 Resolution
P>  Adjustable Lens » 115 Degree Viewing Angle » Operates at 0.05 LUX
Bllnd SPOt camerqs » 105 Degree Viewing Angle » P67 Water/Debris-proof Rated P Built-in Power Loss Protection
» Operates at 0 LUX > Operates at 0.1 LUX »  Anti-Vibration Technology
» 12V Operation » Anti-Glare Windscreen Moulding
Pedestrian Detection CAM-FF03-P-FHD CAM-FLE-1
& Passenger Counter Cameras Tamper-proof Rugged Low-Profile
Forward-Facing Full Fork-Lift Truck Camera
HD 1080P Camera.
» 1/4” CMOS Lens
> 45 Degree Viewing Angle
o » Night Vision Functionality (3m Distance)
qu ke I.lg ht Cd meras » Rugged, Robust Metal Casing
» Operates at OLUX
» E-Marked
Dome Cameras CAM-IC-FHD-P
Image Correction Full
HD 1080P Camera
» Sony CMOS Sensor »  Ultra-Wide 170° Viewing Angle
= Q » Operates at 0.05 LUX »  Full HD 1080p Resolution
ca mera & Monltor Klts » Internal/Windscreen Glass Mount » IP69K Water/Debris-Proof Rating
» Automatic Shutter » Switchable Mirror/Normal View
» GX-Aviation Type Connector > Night Vision Functionality (8-10m)
» Tamper-Proof Casing » E-Marked
» E-Marked

Camera Accessories
CAM-IRF-FHD-P

Rear-Facing Full HD 1080p Camera

with Built-in Microphone & Night Vision

FHD 1080p Image Sensor »  Built-In Microphone

120 Degree Viewing Angle » GX - Aviation Type Connector

Operates down to 0.01 Lux » E-Marked
IP69 Rated

\ A A A4

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com
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FORWARD & REAR-FACING CAMERAS - CONTINUED

CAMERAS

CAMERAS (((J)) ECHOMASTER

CAM-IRF-P-AHD-A
Rear-Facing Full HD 1080P

Camera with Microphone
& Night-Vision

CAM-NPI1-FHD-P

Rear-Facing Full HD 1080P
Number Plate Camera with
Night-Vision

CAM-IPC-IRF

Rear-Facing
Commercial IPC Camera

Front/Rear Full HD 1080P Al-Powered
Pedestrian Detection Camera

>  720p AHD CMOS Sensor » 1080p High Definition » 1/4” CMOS Sensor
> 120 Degree Viewing Angle > 150 Degree Viewing Angle > 45 Degree Viewing Angle
» IP68 Rated » IP69K Rated » Operates at 0.01 LUX
» Operates at 0.01 LUX » Robust Metal Housing » IP66 Rated
» 1000 TV Lines > Night Vision (5m [ 16.40ft)
»  Built-in Microphone > Built-in Audio
>  GX - Aviation Connector Type > Anti-Vibration Technology
» GX - Aviation Type Connector
CAM-PD-REAR-140 CAM-PD-REAR-52

Front/Rear Full HD 1080P Al-Powered
Pedestrian Detection Camera

Camera with Night-Vision

» FHD1080p Image Sensor
» Operates down to 0.01 Lux
> IP69 Water/Debris-proof Rated

Roof Mounted Full HD 1080P

» FHD 1080p Image Sensor
» Operates down to 0.01 Lux
> IP69 Water/Debris-proof Rated

» 140 Degree Viewing Angle »  Alarm Trigger » 52 Degree Viewing Angle »  Alarm Trigger

» Up to 12m Detection Distance P IP69K Rated » Up to 20m Detection Distance P IP69K Rated

» Configurable Detection Zones »  Calibration tool » Configurable Detection Zones »  Calibration tool
» Optional Zone Overlay required for initial » Optional Zone Overlay required for initial
» Updatable via USB setup* » Updateable via USB setup*

»  Optional Wi-Fi Configuration »  Optional Wi-Fi Configuration
CAM-RM-FHD-P

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com

*USB-WIFI-Al & CAM-PD EXTENSION LEAD (SOLD SEPARATELY)

SIDE-FACING CAMERAS

CAM-SM5A-P CAM-SM4A-P CAM-IPC-SM1
Side-Facing Full HD 1080P Side-Facing Side-Mount Metal
Camera 720P Camera IPC Camera
» FHD 1080p Image Sensor » AHD 720P Image Sensor » 1/4” CMOS Sensor
> 140° Viewing Angle » 150 Degree Viewing Angle »  720P Resolution
» IP69 Water/Debris-proof Rated > IP68 Water/Debris-proof Rated » 60 Degree Viewing Angle
» Operates down to 0.01LUX » Operates at 0 LUX » IP65 Water/Debris-proof Rated
»  Built-In Microphone » 1000 TV Lines » Operates at 0.1 LUX
>  GX - Aviation Type Connector »  Built-in Microphone » [P Connection to DVR
» E-Marked » GX - Aviation Type Connector

CAM-PD-SIDE CAM-WMI-AHD-P CAM-MHD-FHD-170

Side-Facing 1080P AHD Wing Mirror Full HD 1080p

Al-Powered Pedestrian Mount Camera Dome Camera

Detection Camera

. » 170 Degree Viewing Angle
> 1/3"Cmos Sensor » Switchable Normal/Mirror View
p»  720P Resolution » IP69K Rated
> 90 Degree Viewing Angle » Built-in Microphone
» Operates at 0 LUX > 12V Operation
> IP67 Rated » Rugged Casing
> Electronic Shutter » GX — Aviation Type Connector
DRIVER-FACING CAMERAS

> 52 Degree Viewing Angle

P Up to 20m Detection Distance

» Configurable Detection - - -

»  Optional Zone Overlay CAM DFII AHD P

: gp(tiatotfl\j%vylg gSB P Internal Driver-Facing

ional Wi-Fi Configuration

> Alarm Trigger Full HD 1080p Camera

> IP69K Rated "

»  Calibration tool required : ]F/usll %hgggessec:i(t)iron

for initial set up* -
» 115 Degree Viewing Angle
*USB-WIFI-Al & CAM-PD EXTENSION » Operates at 0.05 LUX ALSO AVAILABLE AS IPC
LEAD (SOLD SEPARATELY) » Built-in Audio DC-C26-CAM

+44(0)1420 487110 - sales@aampglobal.com

EchoMaster-eu.com
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(((J)) ECHOMASTER CAMERAS CAMERAS

BLIND SPOT CAMERA [ MONITORS

(((J)) ECHOMASTER

PEDESTRIAN DETECTION CAMERAS

° The feature-packed CAM-PD range
DUAL CAMERA FEEDS cccccccccccccccccccs PI‘OtQCtIng offers Full HD 1080p resolution and utilises
: ° Al functionality in real-time to improve
LCD/TFT DISPLAY WITH ccccccccccccs : efee] nst obstacles driving safety and detect potential risks
BUILT-IN AUDIO . . of collision with pedestrians or cyclists
o nayv I ner I up to 20m away.
LONG-RANGE °°: . . and vulnerable
SIDE CAMERA . . o road users. The intelligent detection cameras can
. . . be installed on the side, rear or front of
: . ° various vehicles such as Buses, Coaches,
o ) . Trucks or Construction vehicles.
. . » Eliminates the blind spot The CAM-PD range also comes with
cccesses eoecees ¢ around the A-pillar Anti-Vibration technology and IP69k
e o » Supports WDR/HDR imaging Water/Debris proof rating to provide
‘. .e technology optimum performance even in the most
e » ‘Real-Time' Image synchronisation adverse weather conditions.
o : » Automatic Ambient Light Adjustment
’ . ecccoe » Anti-Glare Night Vision Technology The Al functionality can be calibrated
. : » Waterproof & Dust-proof Casing using a Wi-Fi interface and the cameras
e e » Display with Audio built-in app as well being upgradeable
e » SD Storage (up to 128GB) by USB.
o o - » Supports Optional Third Camera
LONG & SHORT coe ceccccsscns SHORT-RANGE » Automatic Recording on Boot-up > Upto140D Viewing Andl
BRACKETS BLINDSPOT CAMERA » Supports Video Playback plo egree viewing Angie
» Up to 20m Detection Distance
» Configurable Detection Zones
» Optional Zone Overlay
» Updateable via USB
CAM-MON-BS-LHS-KIT CAM-MON-BS-LHL-KIT > Optional Wi fi Contiguration
Left-Hand Drive Left-Hand Drive Qi :
N o » Calibration tool required for setup*
Blind Spot Camera Blind Spot Camera
Display Display
SHORT Bracket LONG Bracket >
140
VIEWING
ANGLE
CAM-MON-BS-RHS-KIT CAM-MON-BS-RHL-KIT
Right-Hand Drive Right-Hand Drive
Blind Spot Camera Blind Spot Camera
Displa Displa
play play CAM-PD-SIDE CAM-PD-REAR-52 CAM-PD-REAR-140
Side-Facing Full HD 1080P Side-Facing Full HD 1080P Side-Facing Full HD 1080P
Pedestrian Detection Pedestrian Detection Pedestrian Detection
Camera Camera Camera
USB-WIFI-Al Wi-Fi Module & EXT-CAM-PD 10 or 15m Extension Lead required for Installation and Initial Set-up
SHORT Bracket LONG Bracket FOR FULL DETAILS - VISIT CAMERA ACCESSORIES SECTION PAGE 29

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com
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PASSENGER COUNTER CAMERA BRAKE LIGHT CAMERAS

Enabling Fleet Managers to increase

Accurate Iy performance & efficiency across their fleets. CAM-VW9-CO
By Accurately recording passenger numbers, .
record pq ssenger transit patterns and behaviour, key info can Replacement OEM Brake nght Camera
be obtained & used for scheduling, forecasting b 1/4” CMOS Sensor
num be rsad nd and all service-related decisions. > 170 Degree Viewing Angle
H The cross-checking of passenger numbers to > IP67 Water/Debris-proof Rated
transit pqtterns' fare transactions also assists in ensuring the > Operates at 0 LUX
correct revenue is obtained, and where required > Parking Lines (Selectable)
» Mirrored Image

action is needed if not the case.

Key Features

Accurately record Passenger Numbers
& Transit Patterns

Enables Cross Checking of Passengers
against Fare Transactions

Used as Standalone Unit or alongside
EchoMaster Connected

Increases Efficiency & Performance
Remotely Updatable

Mobile App available

BRAKE LIGHT CAMERAS DOME CAMERAS

4
- /7 1\

i

vVvVvy VvV VvV V

CAM-SBL-2 CAM-TBL-2 CAM-VBL-2D CAM-MHD-FHD-170 | | CAM-FDIR-AHD-P | | CAM-IPC-FDIR-A-LT
. FullHD 1080 AHD Dome Camera with 720p IPC Dome
Full HD 1080p Mercedes Full HD 1080p Ford Transit Full HD 1080p Mercedes Dome chepru Niaht Vision & Built-In Ccuf\era
Sprinter Third Brake Light Custom Brake Light Vito Brake Light Camera 9
Microphone
Camera Camera
» Full HD 1080p Resolution > 1/3" CMOS Sensor » 720p AHD Resolution
» 170 Degree Viewing Angle » Operates at 0 LUX » Night-Vision Functionality
»  Full HD 1080p Resolution » Full HD 1080p Resolution » Ultra-Wide 150° Viewing Angle » Switchable Normal/Mirror View » Adjustable Camera Direction »  Tamper-proof Metal Casing
» Ultra-Wide 150° Viewing Angle » Ultra-Wide 150° Viewing Angle » Full HD 1080p Resolution » IP69K Rated (0-62 degrees) P Built-in Audio
> P68 Water/Debris-proof Rating > IP68 Water/Debris-proof Rating » IP68 Water/Debris-proof Rating »  Built-in Microphone » Selectable Mirror Image » Operates at 0.01 LUX
» Night Vision Functionality — 8 LEDs » Night Vision Functionality — 8 LEDs P Night Vision Functionality — 8 LEDs » Operates at 0 LUX » Adjustable Camera Direction
» Operates at 0 LUX » Operates 0 LUX » Operates at 0 LUX P 12V Operation » Tamper-Proof Casing
» Easy Installation — Replaces OEM » Easy Installation — Replaces OEM » Easy Installation — Replaces OEM P Rugged Casing » PAL Operation
Brake Light. No drilling required Brake Light. No drilling required Brake Light. No drilling required P GX - Aviation Type Connector
+44(0)1420 487110 - sales@aampglobal.com +44(0)1420 487110 - sales@aampglobal.com
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CAMERAS CAMERAS

(((J)) ECHOMASTER

CAMERA ACCESSORIES

(((J)) ECHOMASTER

CAMERA & MONITORKITS

MCK-70

7" TFT/LCD Monitor
& CCD Camera Kit

The MCK=70 Kit contains a high quality 7" TFT/
LCD display monitor with 2 video inputs and an
included controller. The kit also comes with a IP67
Night-vision camera with a %" Sharp CCD lens
and a 130 degree viewing angle.

Monitor Features

7" High Resolution display
Dual Video Inputs
Reverse trigger detect
Dash Mount Fan Bracket
Remote Control

VVVVYY

Camera

1/4” CCD Sensor

120 Degree Viewing Angle

IP67 Water/Debris-proof Rated
Operates at 0 LUX

18 IR LEDs

VVVYVYY

MCK-70-AHD

7" TFT/LCD Monitor
& AHD Cameral Kit

The MCK-70-AHD comprises of a 7" AHD Dash
Mount monitor, a Commercial AHD camera with
night vision and a 20m GXE Extension Lead. The
MCK-70-AHD provides a High Resolution AHD
image, 3 Video Inputs and 3 Trigger Wires to
enable display switching when used with
additional cameras (available separately).

Monitor Features

7" AHD High Resolution Image
3 x Video Inputs

Supports AHD & Analogue

3 x Trigger Wires

Optional Sunshade

GX16 Connectors

VVVVYVYY

Camera

1/4" CMOS AHD Sensor
720p Resolution Camera
120 Degree Viewing Angle
IP68 Rated

1000 TV Lines

Built-in Microphone
Operates at 0.1 LUX

Auto White Balance

GX16 Connector

VVVVVVYVYYVYY

MCK-70-1P6M

7” TFT/LCD Monitor &
IP69K CCD Commercial
Camera with Night Vision

The MCK=-70-AHD comprises of a 7" AHD Dash
Mount monitor, a Commercial AHD camera with
night vision and a 20m GXE Extension Lead. The
MCK-70-AHD provides a High Resolution AHD
image, 3 Video Inputs and 3 Trigger Wires to
enable display switching when used with
additional cameras (available separately).

Monitor Features

» 7" TFT/LCD Display
» 2xVideo Input
» Remote Control Included

Camera

1/4” CCD Sensor
Operates at 0.5LUX

IP69K Rated

120 Degree Viewing Angle
18 IR LEDs

Mirror Image

VVVVYYVYY

Can’t see what you
are looking for?

All of our Full HD 1080p & AHD monitors are designed to work seamlessly

together and providing endless possibilities.

Should you not see a suitable Camera & Monitor Kit that you require call our friendly
sales team on +44(0)1420 487110 or email echomaster@aampglobal-eu.com who

will be able to help you find the right solution.

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com

CAM-FDIR-AHD-SPC

CAM-SM2-SPC25

EXT-CAM-PD-5

Spacer for CAM-FDIR-AHD-P

Designed to be used with the
CAM-FDIR-AHD-P to enable installation
into more difficult areas or where
clearance is required.

Spacer for CAM-SM4A-P
and CAM-SM2 Range

Designed to be used with the
CAM-SM4A-P & CAM-SM2 to enable
installation into more difficult areas or
where clearance is required.

5m Extension Lead
for CAM-PD range

The EXT-CAM-PD-15 is a 5m
extension for when you require the
Buzzer/Trigger function for signalling
when the customisable detection
zones are triggered.

EXT-CAM-PD-10

EXT-CAM-PD-15

GXA-1

10m Extension Lead
for CAM-PD range

The EXT-CAM-PD-10 is a 10m extension
for when you require the Buzzer/Trigger
function for signalling when customisable
detection zones are triggered.

15m Extension Lead
for CAM-PD range

The EXT-CAM-PD-15 is a 15m extension
for when you require the Buzzer/Trigger
function for signalling when customisable
detection zones are triggered.

Female GX16 Connector to
AV Camera Connection

The GXA-1Adaptor Lead is a

Female GX16 Connector to AV Camera
Connection Adaptor used to connect
old 'Veba’ style cameras to monitors
with GX16 connectors.

GXA-12

GXA-14

GXA-1M-2F

Mercedes Benz 2 Camera
Interface Cable

The GXA-12 is a high-quality camera
interface cable that is designed to allow
the installation of up to 2 high-quality
camera solutions to Mercedes Actros
and Arocs trucks fitted with the JOP
display option.

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com

Mercedes Benz 4 Camera
Interface Cable

The GXA-14 is a high-quality camera
interface cable designed to allow the
installation of up to 4 high-quality
camera solutions to Mercedes Actros
and Arocs trucks fitted with the JOP
display option.

GX-Style Y-Lead

The GXA-IM-2F is a GX-Style Y-Lead
(1 Male to 2 Female) adaptor that
converts one camera input to two
sources with isolated power.

This allows a reverse camera to be
powered from either DVR or Monitor
without feedback.
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CAMERA ACCESSORIES - CONTINUED

CAMERAS

CAMERAS

GXA-2 GXA-3 GXA-4
Female GX16 Connector Male GX16 Connector Male GX16 Connector
to Screw-In AV Style to Screw-In AV Style to Push-In AV Style
Connector Connector Connector

Used to connect old style cameras
to monitors with ‘screw in’ connectors.

Used to connect newer cameras to
older style monitors.

Used to connect newer cameras
to monitors with push-in AV style
connectors.

GXA-5

GXA-6

GXA-7

Male GX16 Connector to
6-Pin Mini Connector

Used to connect newer cameras to
monitors with 6-Pin Connectors.

Female GX16 to Screw-In
AV Style Connector

The GXA-6 Adaptor Lead is a Female
GX-16 Connector to Phono Connector
(with Power)

Male GX16 Connector to
Phono (with Power)

The GXA-7 Adaptor Lead is a Male
GX-16 Connector to Phono Connector
(with Power)

GXE-1

GXE-3

GXE-6

GX16-4 Pin Extension Lead

The GXE-1is a Im extension lead fitted

with a 4-pin aviation type GX connector

to allow the installer to extend the
distance between the camera and
monitor or DVR in an installation.

GX16-4 Pin Extension Lead

The GXE-3 is a 3m extension lead fitted

with a 4-pin aviation type GX connector

to allow the installer to extend the
distance between the camera and
monitor or DVR in an installation.

GX16-4 Pin Extension Lead

The GXE-6 is a 6m extension lead fitted
with a 4-pin aviation type GX connector
to allow the installer to extend the
distance between the camera and
monitor or DVR in an installation.

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com
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CAMERA ACCESSORIES - CONTINUED

IPCE-IM

IPCE-3M

IPCE-5M

©

GX16-6 Extension Lead for
IPC Cameras —=Tm
The IPCE-1M is a 20m GX-16 Style

Extension Cable for use with Echomaster
IPC Camera Products.

GX16-6 Extension Lead for
IPC Cameras —3m
The IPCE-3M is a 20m GX-16 Style

Extension Cable for use with Echomaster
IPC Camera Products.

GX16-6 Extension Lead for
IPC Cameras — 5m
The IPCE-5M is a 20m GX-16 Style

Extension Cable for use with Echomaster
IPC Camera Products.

IPCE-20M

e

MDA-JK-1

MDE-10

S

GX16-6 Extension Lead for
IPC Cameras - 20m
The IPCE-20M is a 20m GX-16 Style

Extension Cable for use with Echomaster
IPC Camera Products.

Micro-DIN to Jack Adaptor

The MDA-JK-1is a Micro-DIN to 3.5mm
Jack Adaptor to connect compatible
products to EchoMaster solutions.

Micro-DIN Extension
Cable - 10m
The MDE=-10 is a 10m Extension Cable

for use with Echomaster Cameras with
Micro-DIN connectors

MDE-20

Micro-DIN Extension
Cable - 10m
The MDE-20 is a 10m Extension Cable

for use with Echomaster Cameras
with Micro-DIN connectors

USB-WIFI-Al

Wi-Fi Module
for CAM-PD-SIDE

The USB-WIFI-Al is a Plug & Play Wi-Fi
Module to enable the programming
of the EchoMaster CAM-PD-SIDE
Pedestrian Camera.

GXE-SZKIT-PF

GX16 Single Suzi
Kit — Push Fit

The GXE-SZKIT-PF utilises 7 Pin
Connectors that terminate to
a Standard DVR Application
4-Pin Aviation Connector.

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com
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CAMERA ACCESSORIES - CONTINUED

SZ-PFK-IPC vs4

Colour-Coded Video Camera

Coiled Cable Switcher IP things

Extension Kit

The SZ-PFK-IPC Extension Kit is designed for use with IP
camera solutions and utilises Commercial Grade 7-Pin
24N connectors that terminate to a Standard DVR IPC
6-Pin Aviation Type Connector.

The SZ-PFK-IPC has colour coded sockets and flexible
cable end to aid driver use.

The VS$41is an Universal 4
Camera Switcher that features
four camera inputs (front, left and
right side, and rear) and one video
output for connecting to a factory
or aftermarket radio with a video
display.

The inputs are triggered by driver behaviour with the

rear back-up inputs automatically activated when the
vehicle is shifted into reverse and side inputs prompted
by the turn signals. The VS41 is a perfect complement to
the versatile universal mount back-up and side blind spot
elimination cameras from EchoMaster.

VI-FORD-SYNC-3-PB

Ford Camera Interface Module

The VI-FORD-SYNC-3-PB is an innovative camera
interface that allows the installation of 2 camera feeds
or inputs such as a compatible DVR or 360 camera
system where specific OE solutions are not fitted.

The camera inputs of the interface can be switched by
utilising the external switch button supplied or the reverse
signal of the vehicle. The LVDS connection to the display
ensures a high-quality, picture with no shaking or loss of
resolution when switching between the camera feeds.

VI-MB10.5NTG6

Mercedes Benz Camera
Interface Module

The VI-MB10.5NTG6 is an innovative interface module
that allows the installation of 2 cameras onto Actros,
Arocs, & Sprinter platforms fitted with the standard OEM
display.

The interface works automatically switching between
the camera feeds and the home screen when not in use
to allow the controls on the standard OEM to still be used.

EchoMaster-eu.com

+44(0)1420 487110 - sales@aampglobal.com

- What do they mean & what do you need?

Here at EchoMaster we are determined to ensure you understand what solutions you purchasing for
your fleet of vehicles. IP (Ingress Protection) ratings is an alpha-numeric system thats determine the
level of protection a particular product has when it comes the ingress of dirt and moisture.

IP69K

What do the numbers mean The second number refers to the rating determines
the amount of liquid ingress the product is protected

The first number refers to the rating against, it is rated between 0 and 9K.

given with regards to ingress of

foreign objects (such as dirt & dust) 0 Not Protected
and is graded from 1-6 1 Vertical Dripping Water
2 Dripping water when tilted up to 15 degrees
0 Not Protected 3 Water spray when tilted up to 60 degrees
1 No objects larger than 50mm 4 Water splash
2 No objects larger than 12.56mm 5 Water jet 6.3mm
3 No objects larger than 2.5mm 6 Powerful water jet 12.5mm
4 No objects larger than Imm 7 Immersion in water up to Im
5 Dust protected, not sealed 8 Immersion beyond Tm
6 Dust tight, no ingress 9K Protection against High-Temp/Pressure Jet Sprays.

Firstly, many cameras today are compatible with both PAL and
NTSC standards.

The NTSC (National Television Standards Committee) Standard is a format that is predominantly used in
America, Japan and other areas, with the PAL (Phase Alternate Line) format common across Europe.

The biggest difference between both PAL or NTSC standard, is the method of colour transmission.
PAL formats require TWO decoders whilst NTSC only needs ONE. This makes NTSC less effective when
displaying colour, but more energy efficient when it comes to power usage. However, tne unique
advantage of PAL is that these cameras can usually be set to NTSC as well.

So, when chossing the right format for your requirements will entirely depend on your preference
and geographical location and the format of the other equipment you will be using alongside your
cameras.

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com
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ADAS & Connected Dash Cams

Dash Cam Kits

THINKWARE™ Dash Cams

Dash Cam Fitting Harnesses

CONNECTED & ADAS DASH CAMS

DC-633-Al

Connected Dash Cam
with ADAS Functionality
The powerful Al-functionality of the DC-633-Al /*\

enables the front-facing 1080p camera to capture
video evidence of the road ahead providing both

real-time and remote warnings including forward

collision, lane departure, and pedestrian detection.

The internal driver-facing camera provides remote feedback
on driver distraction, fatigue, phone usage, and smoking.

° WATCH VIDE)
@

Connect your Dash Cam to our Innovative Cloud-Based
Video Telematics Platform, EchoMaster Connected, and

@@
QO &

: g:ﬁl?_?negr_]gg: sg? 80P & 720P) Recording gain a whole host of extra features and functionality to
»  GPS/GLONASS Functionality keep you in control of your fleet.
P 4G Functionality
»  Evidence Reporting »  Custom ‘Max Speed Alarm b G-Shock (Crash Detection)
) SD Card Storage (up to 256GB) - sold separately » Harsh Braking Alarm » Harsh Acceleration Alarm
P Rugged Aluminium Casing with Heat Sink > Harsh Left/Right Turn Alarm  »  Geo-Fencing

for Optimum Heat Dissipation » Video-Loss Alarm p Custom Alarm Triggers
Full HD 1080P Single Dual HD 1080P Single Full HD 1080P Single
Forward-Facing Forward-Facing Forward-Facing ADAS
Dash Cam Dash Cam Dash Cam

b 143 Degree Front Camera > 143 Degree Front Camera b Wide 140 Degree Viewing Angle
) Option to add a 2nd AHD camera » 2-Way Audio Communication b Built-in Al-powered ADAS

> 2-Way Audio Communication » Built-in 6-Axis G Sensor Functionality includes Lane

»  Built-in 6-Axis G Sensor » Built-in Echo & Noise Cancelling Departure, Distance Detection
»  Built-in Echo & Noise Cancelling P Wi-Fi, 4G & GPS Functionality & Forward Collision Warning

> Wi-Fi, 4G & GPS Functionality » Dual SD Card Storage ) Optional Driver-Facing DMS

» Dual SD Card Storage b Sleep Mode & Remote Turn-On Camera provides warnings for
b Sleep Mode & Remote Turn-On Phone Usage, Smoking,

006®@@00§

Driver Fatigue and Distraction
2-Way Audio Communication
Built-in 6-Axis G Sensor

Built-in Echo & Noise Cancelling
Wi-Fi, 4G & GPS Functionality
Dual SD Card Storage

Sleep Mode & Remote Turn-0On
Quick and Easy Installation

DO

2-WAY BUILT-IN  BUILT-IN DUAL SD NOISE WIDE
COMMS G-SENSOR  WI-FI CARDS CANCELLING VIEWING
(2566GB) TECH ANGLES

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com
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DASH CAMS

DASH CAMS

DASH CAMKITS

DC-6LTS-SC-ER

Full HD 1080p
Connected Dash Cam &
Rear-Facing Camera Kit

The DC-6LTS-SC-ER Full HD 1080p Dash Cam and
Rear-Facing Camera offer a comprehensive safety
solution in almost any vehicle.

DC-6LTS-SC-ES

FullHD 1080p

Connected Dash Cam &
Side-Facing Camera Kit

The DC-6LTS-SC-ES Full HD 1080p Dash Cam and

Side-Facing Camera offer a comprehensive safety
solution in almost any vehicle.

Kit parts: Kit parts:

1x DC-BLTS-SC 1x DC-BLTS-SC

1x CAM-IRF-P-AHD-A 1 x CAM-SM4A

1x GXE-20 1x GXE-6
DC-6LTS-SC-ED DC-6LTS-SC-DF

FullHD 1080p
Connected Dash Cam &
Dome Camera Kit

The DC-6LTS-SC-ED Full HD 1080p Dash Cam and
Rear-Facing Camera offer a comprehensive safety
solution in almost any vehicle.

Kit parts:

1x DC-6LTS-SC

1x CAM-MHD-FHD-170
1x GXE-6

Full HD 1080p
Connected Dash Cam &
Driver-Facing Camera Kit

The DC-6LTS-SC-DF Full HD 1080p Dash Cam and
Side-Facing Camera offer a comprehensive safety
solution in almost any vehicle.

Kit parts:

1x DC-6LTS-SC

1x CAM-DF1-AHD-P
1x GXE-3

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com

DASH CAM FITTING HARNESSES

(((.))) ECHOMASTER

Our Bespoke Dash Cam Harness are designed to enable the pick up of B+, IGN and Ground, in an easy format within
the chassis manufactures approved locations, meaning that if other equipment is already fitted you do not need to
rewire or de-pin any existing wiring it is all plug and play.

HAR-NET-ACTROS

Mercedes Actros
Dash Cam Fitting Harness

COMPATIBLE WITH:
Mercedes Actros 5

HAR-NET-IVSWAY

Iveco Dash Cam
Fitting Harness

COMPATIBLE WITH:
Iveco S-Way Vehicles

HAR-NET-MAN-TGX

MAN Truck Dash Cam
Fitting Harness

COMPATIBLE WITH:
MAN TGX Vehicles

HAR-NET-SPRINT

Mercedes Sprinter Dash Cam
Fitting Harness

COMPATIBLE WITH:
Mercedes Sprinter 907 Vehicles

HAR-NET-TRAN

Ford Dash Cam Fitting Harness

COMPATIBLE WITH:
Ford Transit 2020 > Vehicles

+44(0)1420 487110 - sales@aampglobal.com

EchoMaster-eu.com [ ¥/
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DUAL-INPUT MONITORS

Dual-Input Monitors MON-70 MON-7022-69-AHD
& 7.0” Dash Mount 7" Waterproof
(0 4 Dual Input IP69K Dual-Input
o Monitor Monitor
- Multi-Input Monitors
|
o » 7" High resolution display > 7" AHD High-Resolution Display
» Dual Video Inputs P IP69K Water/Debris-proof Rating
E ° . P Reverse trigger detect » Supports Analogue & 1080p Formats
Mirror Monitors » Dash Mount Fan Bracket included » Built-in Sun/Splash Shield
» Remote Control » 2xVideo Inputs
» 1xTrigger Input
» GX Aviation Type Connector

Monitor Kits MULTI-INPUT MONITORS

MON-7033-AHD-FB

7" IP69K Waterproof AHD Dash
Mount Monitor with Lockable Buttons

7" AHD High-Resolution Display
Supports Analogue & 1080p
Built-in Sun/Splash Shield
IP69K Rated

2 x Video Inputs

1x Trigger Input

GX Aviation Type Connector

VVVVVYVYY

MON-7033-69-1LB

7" IP69K Waterproof
AHD Dash Mount Monitor
with Lockable Buttons

Full 1080p Resolution
Supports Analogue & 1080p
IP69K Rated

Lockable Buttons

E-Mark Certification

VVVVYY

ALL OUR 720P & 1080P CAMERAS ARE COMPATIBLE WITH THE ABOVE MONITORS
TO PROVIDE A MULTITUDE OF OPTIONS.

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com
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MULTI-INPUT MONITORS - CONTINUED

MON-7044-69

7" Dash Mount Quad Input
Water Resistant Monitor

The MON-7044-69 is a dash mount 7” Quad-input monitor
designed for rugged commercial applications.

Designed to resist water damage, the MON-7044-69 is
ideal for vehicles used in uncertain outdoor conditions,
where many consumer-grade monitors and cameras
just won't be suitable.

7" High Res TFT/LCD Display
Quad Video Inputs

4 x Trigger Wires

Multiple Split Screen Options
IP69 Rated

GX16 Connector

VVVVYVYY

MIRROR MONITORS

MM-70-CL-AHD
7" Clip-On AHD Mirror Monitor

The MM-70-CL-AHD is a 7" AHD Mirror Monitor that
attaches to your existing rearview mirror.

The MM-70-CL-AHD will operate as normal until an AV
signal is received through one of the dual video inputs
when the 7" display section becomes a high-resolution
widescreen (16:9) monitor.

» 7.0" Display » Universal Clip-on fitting
» Dual video inputs » Dual mono audio inputs
» Reverse signal trigger P Remote control included

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com
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MONITORKITS

MCK-7-WIFI-MAG

720P Wireless Magnetic Camera
& 7" Dash Mount Digital Monitor Kit

Increase Safety & Improve Visibility when installation is
difficult or where hard-wired solutions arent possible with

the MCK-7-WIFI-MAG, High Definition (720p) Wireless Magnetic
Camera & 7" Dash Mount Digital Monitor Kit.

The robust IP67 rated camera comes with an adjustable viewing
angle and ultra-strong magnetic adhesion making it ideal for a
number of different applications including forklifts, reach stackers,
and other large construction and agricultural machinery.

720p Resolution

Ultra-Strong Magnetic Adhesion
Built-in Rechargable Battery
Night-Vision Functionality
Transmission Distance (up to 200m)
720p Resolution

VVVVVYY

MM-88-CAM

Full Display AHD Mirror Monitor
& 1080p Rear-View Camera Kit

The MM-88-AHD-KIT is a high-quality AHD
Full Display Mirror Monitor and rear-view
camera kit suitable for a number of different
applications.

The titanium oxide coated mirror monitor has
a robust plastic moulded casing and comes
with anti-glare glass ensuring crystal viewing
even in the brightest of weather conditions.

The 1080p Camera comes with a CMOS Image
Sensor and 130 degree viewing angle.

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com
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FOR QUICK

& EASY INSTALL OF ALL
MULTI-CHANNEL DVRS OUR MOBILE DVRS CHOOSE
OUR EASYCHECK VIEWER

TOOL - SEE PAGE 47

Multi-Channel DVRs DVR-50-N-4GG

5-Channel Mobile DVR with
Al-functionality with 4G & Wi-Fi

The DVR-50-N-4GG is a high-performance Mobile

DVR that boasts 4 AHD camera channels and 11PC. EOMAIBLE
DVR / ADAS Add-On gt annels ‘ WITH OUR NEW

Powerful Al-functionality also provides driver warnings MOIS & BSIS

including Driver Fatigue, Distraction, Mobile Phone SYSTEMS

Usage and Smoking warnings. It also comes complete SEERACEE]

with built-in GPS features, 4G connectivity and trigger
output to allow easy integration with telematics
devices and can support up to 256GB SD card storage.

»
o
>
@)
—
m
O
=

]
DVR Accessories » 4 xAHD Channels +1x IPC » Al-functionality
» 2xSD Card slots (256GB) » Lockable Storage Case
P Integrated GPS & 4G Connectivit P 6-Axis G-Shock Sensor
» 12-24V Compatible (8-36V input
» Compatible with Touch Panel
DVR-50-FHD-WG

5-Channel Mobile DVR with
Al-functionality with GPS & Wi-Fi

The DVR-50-FHD-WG is a high-performance Mobile DVR boasting

4 AHD camera input channels as well as 11PC channel. Complete with
built-in GPS features, Wi-Fi connectivity and trigger output to allow
easy integration with telematics devices, it can support up to

256GB SD card storage

4 AHD Channels + 11PC channel

2 x SD card slots (Up to 256GB)
Lockable Storage case

3-Axis G-Shock sensor

Integrated GPS & 4G connectivity
Compatible with Touch Panel
12V-24V compatible (8V-36V input)
Additional Trigger in and outputs

VVVVVVYVYY

DVR'ISO'N-4GG COMPATIBLE

WITH OUR NEW
MOIS & BSIS

5-Channel Mobile DVR with HDD e TEne
Storage, GPS & 4G Connectivity SEE PAGE 57

A high-performance Mobile Digital Video Recorder, boasting 4 AHD
channels and 1IPC channel. The DVR-150-N-4GG provides ADAS Blind
Spot Detection and Driver Status Monitor (DSM). Complete with built-in

4G connectivity and GPS functionality, it also features a 2TB Hard Disk Drive
(HDD) storage and external trigger output.

4 x AHD Channels + 1x IPC Channel
Full HD 1080p Resolution
Upto 1TB HDD Storage

Lockable Case to protect your data

Integrated GPS

Built-in 6-Axis G-Sensor g a‘
12-24V (8-36V input)

Additional Trigger in and outputs

+44(0)1420 487110 - sales@aampglobal.com
EchoMaster-eu.com
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MULTI-CHANNEL DVRS - CONTINUED MULTI-CHANNEL DVRS - CONTINUED

5-Channel Mobile DVR 12-Channel Mobile DVR with . .
with HDD Storage & GPS HDD Storage, GPS & 4G Functionality
» Full HD 1080P/720P/D1 resolution
» 8 AHD Channels + 4 IPC channels*
» Supports up to 2TB HDD & 256GB SD card storage
> FulD 080r 720P o rescutin i e N
4 AHD + 1IPC channel . .
P Supports Up to 2TB Hard Disk Drive (HDD) > Remote Wake-Up functionality
: Lockable Storage case (to protect data) : :32L<;I—t£zjvec:_<)srrr11(;(;ktist)?2?g(/—26V input) I,f
Integrated GPS connectivity - ! ! it
» Remote Wake-Up functionality — » Additional Trigger in and outputs lR&
» Built-in 3-Axis G-Shock sensor = D _ . .
> 12V-24V compatible (8V-36V input) I"R& IPC-PON-4 Switch required
» Additional Trigger in and outputs I
5-Channel Mobile DVR
. DVR-DAD-KIT DVR-RW-AI-DASH
with HDD Storage, GPS
& Wi-Fi DMS & Advanced Driver R-Watch Display
Assistance (ADAS) Kit for DVR-DAD-KIT
» Full HD 1080P/720P/DI1 resolution
The DVR-DAD-KIT is a
+ -RW-AI- -
: SF/)-\ IE'OD#E?SS?OT ISisk] IIDZC\:/: ?SBB()EI— sold separately comprehensive status warning TDrlwse II:;VRisl::t":|elgllicl:<:tl.\esol|-ldRis V\Ilcc: <"
> Lockable Storage case (to protect data) solution designed to monitor des’,:i) nyed to be used with l?hey
> Integrated GPS connectivity complex road situations and driver DVR—gDAD—KIT nd alerts th
» Remote Wake-Up functionality behaviour in. the cabin to help driver whenevce‘er thc:e zy:terg
P Built-in 3-Axis G-Shock sensor prevent accidents up ahead. ;D EE detects a potential hazard.
> 12v-24V compatible (8V-36V input) ' m » 1080p Front-Facing ADAS Camera
» Additional Trigger in and outputs allow for —— > Driver Facial-Analysis Camera
integration with telematics devices » Dedicated display alerts the driver of a potential hazard
» Improves safety for your drivers and reduces the risk of costly incidents
» Can be used with an EchoMaster Connected system to create a secure,
closed-loop for data gathered by the kit and access your data remotely
from your devices
DVR-344' N-4GG COMPATIBLE » Provides a range of warnings for the driver and operator including Fatigue,
. nglsogRBg'IEsw Distraction, Lane Departure, Forward Collision, Distance Monitoring & more.
8-Channel Mobile DVR SYSTEMS > Designed for use with EchoMaster FHD 1080p DVR range
with HDD Storage, GPS SEEPAGEST
& Wi-Fi
L]
Full HD 1080P/720P /D1 Resolution Want an easier way to compare
4 AHD Channels + 4 IPC Channels*

L]
Supports up to 2TB Hard Disk Drive & 256GB SD Card Storage all DVR solutions?
Lockable Storage Case (to protect data)

Integrated GPS & 4G Connectivity

Remote Wake-Up Functionality >

Built-in 6-Axis G-Shock Sensor o
12V-24V compatible (8V-36V input) m é E aglll o
Additional Trigger in and outputs allow ——]

for integration with telematics devices

+44(0)1420 487110 - sales@aampglobal.com +44(0)1420 487110 - sales@aampglobal.com
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TURN OVER FOR OUR COMPREHENSIVE RANGE OF DVR ACCESSORIES >>
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DVR ACCESSORIES

DVR-150-HCAD

Heated HDD Caddy
for DVR-150 range

The DVR-150-HCAD is a

Heated Caddy for use with the
DVR-150 range of Mobile DVR
solutions. It is designed to allow
the Hard Drive (sold separately)
to be kept within its optimum
working temperature range to
ensure no loss of data evenin
the harshest of weather

DVR-50-TH-CAB

DVR Trigger Harness for
DVR-50 & DVR-150 range

The DVR-50-TH-CAB is a
Multi-Pin Trigger Harness
with bare ends that connects
Trigger Inputs and Outputs to
DVR-50 and DVR-150 ranges.

conditions.
DVR-350-HCAD DVR-580-HCAD
HDD Caddy Reader HDD Caddy Reader
for DVR-350 range for DVR-580 range

The DVR-580-HCAD is a
Heated Caddy for use with

the DVR-580 Mobile DVR. It is
designed to allow the Hard
Drive (sold separately) to be
kept within its optimum working
temperature range to ensure
no loss of data even in the
harshest of weather conditions.

The DVR-350-HCAD is a
Heated Caddy for use with
the DVR-350 Mobile DVR.

It is designed to allow the
Hard Drive (sold separately)
to be kept within its optimum
working temperature range
to ensure no loss of data even
in the harshest of weather

conditions.

DVR-150-READ DVR-350-SR-CAB
Caddy Reader DVR Serial Cable

for DVR-150 for DVR-350 range
range

The DVR-150-READ is used to transfer video files from
either DVR-150 or DVR-350 devices directly to your PC
using the EchoMaster Connected Viewer software.

The DVR-350-SR-CAB Adapter
Cable with bare ends allows
serial data connections to the

. DVR-350 Mobile DVR.
Powers HDD directly from USB ports

Additional power input (if required)
Status LED’s
USB 3.0
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MOBILE DVR RANGE

DVR ACCESSORIES - CONTINUED

(((J)) ECHOMASTER

DVR-350-TH-CAB
DVR Trigger Harness for DVR-350 range

» 8xConfigurable Trigger P Speed Pulse Output
Inputs for External Inputs ~ »  1x12V Output

» 2 xConfigurable Alarm
Outputs

DVR-580-TH-CAB
DVR Trigger Harness for DVR-580 range

The DVR-580-TH-CAB is a
DVR trigger harness for use
on the DVR-580 range.

It features 8 configurable
trigger inputs for external
inputs, 2 configurable alarm
outputs, speed pulse inputs,
12v and 5v outputs, RS232
inputs and RS485 inputs.

DVR-APPCHK

EasyCheck Viewer Tool

DVR-VOA-1004

GX-16-4 t0 10 Pin
Adaptor Lead

The DVR-VOA-2 is a GX16 Adapter Lead designed to
connect a monitor with a standard 4-pin aviation type
connector to any product in the DVR-50/150 Mobile
DVR range.

» Wi-Fi Connection

» Plug & Play

» SD Card Slot

> Video File Backup to SD card The DVR-VOA-1004 is a GXI16 to 10 pin Adapter Lead
> Device status checking designed for use with the DVR-350/380/580 Mobile
> Real-Time Preview Available DVR range where connection to monitor with a

> Easy Device Firmware Updating standard 4-pin aviation type connector is required.
DVR-VOA-2 DVR-WPENC-KIT-150

GX16 4 Pin Waterproof Fitting

to GX16 4 Pin Enclosure for

Monitor Adaptor DVR-150 range

The DVR-WPENC-KIT-150 is a rugged, waterproof DVR
Fitting Enclosure designed to eliminate the ingress of dirt,
dust and moisture and protect your DVR where external
installation means the system would be exposed to the
elements. The case also comes pre-terminated for plug
& play installation with the DVR-150 range.
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EchoMaster-eu.com [-¥/



https://echomaster-eu.com
https://echomaster-eu.com

(((J)) ECHOMASTER

DVR ACCESSORIES - CONTINUED

HDD-TOSH-1TB

DVR Serial Cable
for DVR-350 range

The HDD-TOSH-1TB is a 2.5” SATA 1
TB Hard Disk Drive (HDD), optimised
for mobile solutions incorporating
Toshiba Dynamic Cache Technology
to enhance access performance.

1TB Storage

Built-in Shock Sensor
128MB Buffer

Weight: 117g

Operating Temperature
-40°C~+65°C
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MOBILE DVR RANGE MOBILE DVR RANGE (((,))) ECHOMASTER
NON-CONNECTED DVRKIT
HDD-TOSH-2TB SD-256 DVR-5CH-HDD-TH-UC
DVR Trigger Harness Standard-Size Class 10 Non-Connected 1TB

for DVR-350 range

The HDD-TOSH-2TB is a 2.5" SATA 1
TB Hard Disk Drive (HDD), optimised
for mobile solutions incorporating
Toshiba Dynamic Cache Technology
to enhance access performance.

1TB Storage

Built-in Shock Sensor
128MB Buffer

Weight: 117g

Operating Temperature
-40°C~+65°C

VVVVYVYY

256GB SD-Card

The SD-256 is a Standard size Class
10 SD Card for use with Echomaster
Dashcams or DVR systems.

» For industry-standard
professional applications

(4K and 8K resolution)

UHS-II video speed class (V90)
256GB Capacity

300MB/s read, 260MB/s write

\A A4
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Digital Video Recorder Kit

The DVR-5CH-HDD-TH-UC makes installtion quick
and easy providing all the requirements parts in one box.

The Kit consists of High-Performance 5 Channel DVR
with Built-in G-Sensor, Tamper-proof casing & GPS
functionality. It is also supplied with a 1TB Hard Disk
Drive (HDD) and DVR Trigger Harness.

KIT CONTENTS

» DVR-150-FHD-G
» DVR-50-TH-CAB
» HDD-TOSH-1TB

ALSO AVAILABLE WITH A 2TB HARD DRIVE
DVR-5CH-HDD-TH-UC-2

eS80

CONNECTED DVRKIT

DVR-5CH-HDD-TH-C

Connected 1TB
Digital Video Recorder Kit

The DVR-5CH-HDD-TH-C makes installtion quick and easy
providing all the requirements parts in one box.

The Kit consists of High-Performance 5 Channel DVR
with Built-in G-Sensor, Tamper-proof casing, 4G & GPS
functionality. It is also supplied with a 1TB Hard Disk
Drive (HDD) and DVR Trigger Harness.

KIT CONTENTS

» DVR-150-N-4GG
» DVR-50-TH-CAB
» HDD-TOSH-1TB

ALSO AVAILABLE WITH A 2TB HARD DRIVE
DVR-5CH-HDD-TH-C-2

80
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Side-Alert Sensors

Multi-Frequency Reversing Alarm

Multi-Input Reversing Alarm

Night-Silent Alarm

Standard Reversing Alarm

Accessories

Lighting Solutions

SIDE ALERT SENSORS

SA-IP69-SPM

IP69K Side Alert Kit with Speed Pulse
Trigger for Commercial Vehicles

Dip Switch Settings for Detection Zone
Distance and Warning Adjustment
Audible & Visual Warning

OE Sounding Buzzer

Daisy Chained High Sensitivity

IP69K Sensors

Wide Detection Angle with

Minimal Blind Spot Area

Triangulation Technology

The system consists of 4 x IP69K
Water/Debris-Proof High Sensitivity
Sensors that can be flush mounted or
underslung when used with the brackets
provided, along with an IP69K System
Control Box. The SA-IP69-SPM also
comes with a Speed Pulse & Indicator
Trigger Module which activates the
sensors when the vehicle is at low speed.
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MULTI-FREQUENCY REVERSING ALARMS

WNA-1-EM

Multi-Frequency Reversing Alarm

The WNA-1-EM is a versatile Multi-Frequency Reversing Alarm
that eliminates nuisance noise by providing greater directional
information than that of a traditional alarm.

Multi-Frequency Broadband Sound
Instantly Locatable Sound

IP68 Water/Debris-proof Rating
Eliminates Noise Nuisance

Sound confined to danger area
Clear Audible Warning

VVVVYYVYY

MULTI-INPUT REVERSING ALARM

MMA-1
Multi-Input Warning Alarm

The MMA-1is a Robust Multi-Input Safety Warning Alarm
providing external warnings when the vehicle is manoeuvring.
The alarm has inputs for left and right turn (spoken warnings%
and for either a spoken or beeping reversing alarm along
with an IP68 Water/Debris-proof Rating.

> Fully Automatic no activation required.  » 12/24V Compatible

P> Multi-Inputs — One Unit Covers All » Clear Audible Warnings

> IP68 Water/Debris-proof Rating P Night Time Mute Capability
>

97dB +/- 4dB at 4ft

+44(0)1420 487110 - sales@aampglobal.com
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SENSORS & ALARMS

DOUBLE ENGAGE NIGHT SILENT ALARM

RA-DTA-1
Double Engage Night Silent
Reversing/Warning Alarm

It has built-in Night-Silent functionality
allowing it to be muted at certain times

of the day. It is ideal for larger commercial
applications such as lorries, trucks, and
construction vehicles.

The RA-DTA-1 provides audible warning for » Rugged, Robust Casing
pedestrians and other road users when a > IP68 Water/Debris-proof Rating
vehicle is manoevring or reversing. » Clear Audible Warning

STANDARD REVERSING ALARM

RA-02-102
12-24V Reversing Alarm

The RA-02-102 is a robust 12-24v
IP67-rated reversing alarm suitable for
large commercial vehicles such as lorries
and trucks.

P 12-24V Operation > 102dB +/- 3dB
> IP67 Water/Debris-proof rating » Robust Nylon Casing

SA-SPM

Speed Pulse & Indicator
2-in-1Trigger Module

The SA-SPM is a speed accessory control unit which
uses the tachograph speed signal to switch on the side
alert or turn alarm dependant on vehicle speed

or indicator use.

SPG-GPS-12
Speed Pulse Module

The SPG-GPS-12 Speed Pulse
Module uses GPS technology
to generate two road speed
dependant outputs. The first
output pulses at a frequency
proportional to road speed.
The second output changes
state when a pre-set road
speed is exceeded.

The interface is easy to install
and utilises a built-in antenna.
It is suitable for 12v and 24v
vehicle electrical systems.

EchoMaster-eu.com
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Designed to create a visual warning around vehicles operating
ro ‘ : o u r in high-traffic areas such as loading bays, warehouses and
delivery yards, the SL-BL-10-80 Blue Linear Worklight is

suitable for a number of different applications.

o
Wo r kfo rce I n With multi-voltage operation it can be easily installed into the
existing vehicle wiring and when combined with multiple lights

creates an all-round ‘safe space’ alerting your work-force to

— — the presence of vehicles such as forklifts, side loaders and
I g — ra I c HGVs reversing.

» Emits a Blue Warning Light Strip » IP67 Rated

» Multi-Voltage Operation (10-80V) » Power: 6W
® » Single Bolt Mounting » E-Marked

000 @
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FORS PRODUCTKITS

FORS Product Kits A scheme open to all fleet operators, FORS accreditation
aims to raise the levels of safety and quality throughout their
operations and to demonstrate exemplary levels of the best
practice in safety, efficiency, and environmental protection.

DVS Compliant Solutions The blind spots of large commercial vehicles are becoming a
major factor in collisions on the UK's roads with the increased
height and length of many vehicles and machines greatly
limiting driver visibility. Driver & Operator positions, vehicle
panels, no rear windows or solid bulkheads all create further
restrictions
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Benefits of FORS-compliant safety solutions

» Provides an Enhanced Duty of Care
» Protects against False Claims

» Increases Fleet Efficiency

» Improves Overall Safety

Allows for Driver Training or Reward
Lowers Operational Risk

Deters Vehicle Damage & Theft
Protects your Investment

000000
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FORS-GOLD-KIT FORS-GOLD-KIT

High-Definition FORS Gold Kit High-Definition FORS Silver Kit
L3 o

What's in the ‘box’ What's in the ‘box’

» 1x7"2 Channel AHD Monitor » 1x7"2 Channel AHD Monitor

» 1xFull HD 1080p Forward-Facing Camera » 1xFull HD 1080p Forward-Facing Camera

» 1xFull HD 1080p Rear-Facing Camera » 1xFull HD 1080p Rear-Facing Camera

» 2 x AHD 720p Side-Facing Cameras » 2 x AHD 720p Side-Facing Cameras

» 4 xUltrasonic Side-Aleet Sensors » 4 xUltrasonic Side-Aleet Sensors

» 1x5-Channel DVR with GPS & 4G Functionality » 1x5-Channel DVR with GPS Functionality

» 1x1TB Hard Drive (HDD) » 1x1TB Hard Drive (HDD)

P 1xMulti-Input Warning Alarm > Multi-Input Warning Alarm

» 1xFitting Accessories Cables > Fitting Accessories Cables

+44(0)1420 487110 - sales@aampglobal.com
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DVS COMPLIANT SOLUTIONS

The Progressive Safety System is a series of vehicle safety
enhancements built around the initial DVS ‘Safe System’
launched back in 2019, with the emphasis on acheiving zero
deaths or serious injuries on Londons roads by 2041.

The Progressive Safe System (PSS) enhancements have been developed based on consultations L tasenes
and reflect the latest equipment and technologies available in the market. Under this new system,
all HGVs must now meet a minimum three-star DVS rating from 28th October 2024.

To give the freight industry enough time to obtain, fit and validate new equipment where required,
TfL have applied a limited grace period for vehicles that have registered with TfL by 28 October 2024
and can demonstrate they have taken steps to arrange for the fitting of a Progressive Safe System (PSS).

What are the Progressive Safe System requirements

@ E_A The BSIS-MOIS-AI3C is a High Performance Combined Blind Spot & Moving-Off
Information System with Full HD 1080p Cameras together with Al-powered warning

system and driver alerts.

Any Operational Camera A Blindspot Information A Moving-off Information An audible vehicle
Monitoring System mustbe  System (BSIS) with ‘active’ system (MOIS) must be fitted manoeuvring warning Designed to conform to the new TfL
fltte.d to the nearside of the sensors that provides to the front pf the vehicle to must k?e fitted to qll vehicles Direct Vision regulations, It utilises
vehicle, to completely adequate alerts to the warn the driver to the including those with left-hand Sl G e e i e
eliminate any remaining presence of Vulnerable road presence of pedestrians or drive to ensure all vehicles powertul algoryth Y
blind spot areas. users and NOT roadside cyclists entering the front have the ability to warn both pedestrians, cyclists and other "
furniture. It must be fitted to blind spot area. It must pedestrians or cyclists of an vulnerable road users (VRUs) within the
the nearside of the vehicle activate to a range of 2m, intended manoevre. detection zones stipulated by the new
with a detection range 2m and as like the BSIS, not Progressive Safe System.
(high), 2.2m from the side detect up roadside furniture
and 9m from the front. or parked vehicles. Vehicles
A vehicle that complies that comply with UNECE - Full HD 1080p Forward-Detection Camera
with UNECE Regulation 151 Regulation 159, will meet this - Super-Wide 1080p Road-Facing Camera
will meet this requirement. requirements - Rear-View Full HD 1080p Camera

- 6-Axis G-Sensor designed to detect Rapid
Acceleration, Braking, Turning and Collision

Detecti
VIEW RANGE >> FIND OUT MORE >> FIND OUT MORE >> VIEW RANGE >> _ Supports the addition of a Forward-Facing

camera solution (for example MOIS)
- Self-Learning Motion Trend Analysis
Algorithm to eliminate unvalid alarms
- Simple Installation & Set-up

Find out how we can help with your PSS requirements CLICK HERE FOR FULL SPECIFICATIONS >>
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RM1800WEM
EchoMaster Heavy Duty Headunit - RADIO ONLY

World FM/AM/LW Tuner

4 x 40 Watts

USB/MP3 Functionality

3.5mm AUX Input

1 Amp USB Charging

EEPROM Memory

Multi-Format ISO Wiring

Engineered for Agriculture & Construction

The RMI800WEM has been designed for use in a range of heavy-duty
vehicles. With its rugged and durable construction and All-Angle Display
the RMI800WEM can be installed in multiple locations.

The World Tuner provides radio reception in almost all countries.
The RMIBOOWEM has also been ergomically designed for ease of use
and has both USB and AUX inputs for connection of multiple devices.

VVVVVVYVYY
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RMIBOIWEM World FM/AM/LW Tuner
Bluetooth Handsfree & Music Streaming
EchoMaster Heavy Duty Headunit 4 x 40 Watts
- Radi IBIuetooth Built-in Microphone
adio External Microphone (optional)

1 Amp USB Charging

EEPROM Memory

Multi-Format ISO Wiring

USB/MP3 Functionality

3.5mm AUX Input

Engineered for Agriculture & Construction

The RMI80TWEM has been designed for use in a range of
heavy-duty vehicles. With its All Angle Display it can be
installed in multiple locations. The World Tuner provides radio
reception in almost all countries. It has also been ergomically
designed for ease of use and has both USB and AUX inputs for
connection of multiple devices.
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@ ECHOMASTER AUDIO SOLUTIONS AUDIO SOLUTIONS @ ECHOMASTER

RM2000

Short Chassis Heavy Duty Headunit
- Radio Only

RM2001

Short Chassis Heavy Duty Headunit
- Radio/B'tooth

World FM/AM/LW Tuner
Bluetooth Handsfree & Music Streaming
DAB/DAB+ Tuner

Requires DAB Antenna System
4 x 40 Watts

Built-in Microphone

External Microphone (optional)
1Amp USB Charging

EEPROM Memory

Multi-Format ISO Wiring
USB/MP3 Functionality

3.5mm AUX Input

RM1802WEM

EchoMaster Heavy Duty Headunit
- Radio/Bluetooth [DAB/DAB+

The RM1802WEM has been designed for use in a range of
heavy-duty vehicles. With its rugged and durable
construction and All Angle Display the RMI802WEM can be
installed in multiple locations. The World Tuner provides radio
reception in almost all countries. The RMIB02WEM has also
been ergomically designed for ease of use and has both USB
and AUX inputs for connection of multiple devices.
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Benefits of the RM2000 Range

Conformal Coating - To seal the circuit board and all vital components
eliminating the effect of corrosion, dust and moisture ingress.

72 Hour Open ‘Salt Spray’ Tested — Designed to eliminate possible dendritic
growth and reduce the possible short circuit of components when exposed
to harsh environmental factors.

‘Hot-Box’ Tested — To identify and remove any faulty components by
exposing them to high temperature endurance ensuring correct operation.
Chemically Tested — A comprehensive list of common household and
automotive chemicals are tested to ensure the units functionality is not
affected when exposed to such chemicals.

Designed to Manage Dust & Dirt — All unit openings and exposed areas are
rubber sealed to minimise dust & dirt ingress, ensuring their function is not
impaired. For example, the screen. Although not sealed, it is sheilded with
air flow managed to reduce any dust settling between the lens and the
display LCD.

Vibration Tested — Reducing the effect of component failure when
operated on rough and uneven terrain such as construction and
agricultural locations ensuring correct operation.

Robust Button Operation — The fixed front panel of the unit has been
designed to withstand heavy user operation when vehicle is in use.
Comprehensive Approvals — The RM2000 range has a comprehensive
range of approvals and certifications: RED Approved, CB Approved,

CE Approved, E-Marked, FCC-ID, FCC Approval, IC Approval and

LVD Approval for worldwide use.

RM2003

Short Chassis Heavy Duty Head Unit
- Radio/B'tooth/DAB

RM2004

Short-Chassis Heavy Duty Head Unit
- Radio/B’tooth/DAB/CAN
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@ ECHOMASTER

AAMP Global, Woolmer Way, Bordon,
Hampshire, GU35 9QE, United Kingdom

UK/Europe

+44 (0) 1420 487110 - echomaster@aampglobal-eu.com
Technical Support - echotec@aampglobal.com

@ EchoMaster-eu.com o @echomastereurope

m @ec:homastereurope @echomostereurope

EchoMaster Europe is a brand of AAMP Global.
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